Integrating SAP Hybris Cloud for Customer with SAP Hybris Marketing Cloud using HANA Cloud Integration
Integration Guide

February 2017
# Table of Contents

Integrating SAP Cloud for Customer with SAP Hybris Marketing Cloud using HANA Cloud Integration...... 3  

1 Configuration in SAP S/4 HANA ..................................................................................................... 4  
1.1 Overview .................................................................................................................................. 4  
1.2 Administrator Business User ................................................................................................. 4  
1.3 Tips on how to gather required HCI and C4C information ................................................... 4  
1.4 Maintain Communication System .......................................................................................... 5  
1.5 Maintain Communication User .............................................................................................. 7  
1.6 Maintain Communication Arrangement ................................................................................ 8  
1.7 How to get the S/4HANA System URL .................................................................................. 11  
1.8 How to get the S/4HANA Client Certificate ......................................................................... 12  
1.9 How to get the Logical System ID ......................................................................................... 12  
1.10 Tips on finding Errors during Outbound Processing of Messages ..................................... 12  

2 Configure Integration in SAP Cloud for Customer .................................................................. 14  
2.1 Activate SAP Hybris Marketing Cloud Integration in Scoping ............................................... 14  
2.2 Set Up Communication System ............................................................................................ 15  
2.3 Configure Communication Arrangements .......................................................................... 16  
2.4 Change the Assignment of Categories ................................................................................. 20  
2.5 Perform Code List Mapping ................................................................................................. 20  

3 Configure Integration in SAP HANA Cloud Integration (HCI) .................................................... 23  
3.1 Configure S/4 HANA Communication User Credentials using SAP HCI Web UI .................. 23  
3.2 Configure and Deploy Integration Flows using SAP HCI Web UI ........................................ 23  
3.3 How to get the HCI Runtime URL ....................................................................................... 24  
3.4 How to get the Integration Flow endpoints in HCI ............................................................... 25  
3.5 How to get the HCI client certificate ..................................................................................... 25  
3.6 View and Extend the Deployed Integration Flows using SAP Eclipse .................................. 25  
3.7 Maintain Value Mapping ........................................................................................................ 26  

4 Initial Load of Data ..................................................................................................................... 31  

Copyrights, Trademarks, and Disclaimers .................................................................................... 32
Integrating SAP Cloud for Customer with SAP Hybris Marketing Cloud using HANA Cloud Integration

About this Document
This document describes the configuration steps necessary to integrate SAP Cloud for Customer with SAP Hybris Marketing Cloud using SAP HANA Cloud Integration (HCI). It is important that the individual systems being integrated are already set up.

The document is intended only as a guide to help you prepare and apply the steps necessary for successful integration. Before you start working through this document, ensure that you have downloaded the most recent version of this document available on SAP Service Marketplace.

Support
If you have any queries or feedback on this document, please create a ticket for the component LOD-CRM-INT-YMT.
1 Configuration in SAP S/4 HANA

1.1 Overview
To set up certificate-based authentication between SAP S/4HANA and HCI an administrator needs to create a communication user, a communication system and a communication arrangement.

1.2 Administrator Business User
The administrator business user needs to have a business role, which contains the business catalog SAP_CORE_BC_COM (Communication Management), e.g. the business role SAP_BR_ADMINISTRATOR (Administrator).

1.3 Tips on how to gather required HCI and C4C information
In the following chapters, you have to know some HCI information. Below it is described how you can retrieve this information.

| Upload Certificate (Communication User) | See chapter How to get the Integration Flow endpoints in HCI
You get the endpoint of an integration flow from the following place once the integration flows are deployed. See Configure and Deploy Integration Flows using SAP HCI Web UI
In the HCI Web UI, navigate to Monitor. Click on the Started tile.
Search for the integration flow e.g. Replicate Lead with Business Partner Address Information from SAP Business Suite. Click on status Started. The second part of the listed endpoint starting with /cxf/ is the needed service endpoint. Example: /cxf/yMKT/C4C/LeadReplicationRequest_Out
How to get the HCI client certificateHow to get the Integration Flow endpoints in HCI
You get the endpoint of an integration flow from the following place once the integration flows are deployed. See Configure and Deploy Integration Flows using SAP HCI Web UI
In the HCI Web UI, navigate to Monitor. Click on the Started tile.
Search for the integration flow e.g. Replicate Lead with Business Partner Address Information from SAP Business Suite. Click on status Started. The
second part of the listed endpoint starting with /cxf/ is the needed service endpoint. Example: /cxf/yMKT/C4C/LeadReplicationRequest_Out

How to get the HCI client certificate

<table>
<thead>
<tr>
<th>Host Name (Communication System)</th>
<th>See chapter How to get the fully qualified HCI runtime URL. Remove the prefix https:// from the URL.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path (Communication Arrangement)</td>
<td>Retrieve the endpoints of the integration flows Replicate Lead with Business Partner Address Information from SAP Business Suite and Replicate Activity from SAP Business Suite as described in chapter How to get the Integration Flow endpoints in HCI.</td>
</tr>
<tr>
<td>Host Name (Cloud for Customer System)</td>
<td>Retrieve the URL from the notification e-mail from SAP Cloud for Customer.</td>
</tr>
</tbody>
</table>

1.4 Maintain Communication System

Overview

The Communication system is used to define the host name of the HCI tenant and to assign users for the inbound (from HCI to SAP S/4 HANA) and outbound communication (from SAP S/4 HANA to HCI).

Additionally, a second communication system with the host name of the Cloud for Customer system is needed to enable the navigation from SAP S/4 HANA to SAP Cloud for Customer. A communication user is not needed here.

1.4.1 Communication system for HCI (C4C Integration)

Procedure

1. Log on to your SAP S/4 HANA system as an administrator.
2. Choose the Communication Systems tile.
4. Enter the ID and System Name and choose Create. The pop-up disappears.
5. Optionally enter some notes in Notes in General Data.
7. Maintain the host name of the fully qualified HCI runtime URL (see chapter 1.3 on how to get the URL)
8. Set SAP System on No.
9. You do not have to maintain the remaining fields.
10. Optionally, maintain Contact Information.
12. Choose button. A pop-up appears.
14. Select the communication user you created in chapter 1.5 in value help of User Name.
15. Choose OK and the pop-up disappears.
17. Choose button. A pop-up appears.
20. Choose Create to create the S/4HANA client certificate. The pop-up disappears.
21. Choose Save to save the communication system.
1.4.2 Communication system for C4C (UI Navigation)

Procedure

1. Choose New again.
2. Enter a new ID and meaningful System Name and choose Create.
4. Maintain the host name of the fully qualified C4C UI server (see chapter 1.3 on how to get the URL)
5. Press Save.

1.5 Maintain Communication User

Overview

The Communication user defined in S/4 HANA system is used for inbound communication and processing messages in the system. Technically, the user is needed to call OData services in S/4 HANA from HCI.

Procedure

1. Log on to your SAP S/4 HANA system as an administrator who has the required authorization.
2. Choose the Maintain Communication Users tile.
3. Choose *Create*.
4. Enter the *User Name, Description* and *Password*.
5. Choose *Upload Certificate* to upload the HCI client certificate.
6. A pop-up appears. Upload the certificate. The pop-up disappears.
7. Choose *Create*.

**Note**
In the HCI system, you need this technical user to call the OData services.

### 1.6 Maintain Communication Arrangement

#### Overview
The Communication arrangement in S/4HANA system defines all relevant information for the communication with HCI. For example, it contains the communication system, inbound and outbound authentication, and if the integration is done for Cloud For Customer or for CRM. Additionally, a second communication arrangement is needed to enable the navigation from SAP S/4 HANA to SAP Cloud for Customer.

#### 1.6.1 Communication Arrangement for HCI (C4C Integration)

**Procedure**
1. Log on to your SAP S/4 HANA system as an administrator.
2. Choose the Maintain Communication Arrangements tile.
3. Within the App “Maintain Communication Arrangements”, check if an arrangement for scenario “Marketing - Presales/Sales Integration” already exists.
4. If not, click on the “New” button. A pop-up appears.
5. Select communication scenario “SAP_COM_0017 (Marketing - Presales/Sales Integration)” in value help of Scenario.
6. Enter a meaningful Arrangement Name.
7. Choose Create and the pop-up disappears.
9. Select the communication system for the HCI you have created in chapter 1.4.1 in value help of Communication System.
11. Select Target System Type “SAP_C4C (SAP Hybris Cloud for Customer System)” via value help.
   The Communication user maintained in the communication system is entered by default.
   The outbound user maintained in the communication system is entered by default.
15. Service Status should already be flagged as “Active”
16. Port should already be filled with value “443”.
17. Maintain the URLs to the service endpoints of the services you want to use.
18. See chapter Tips on how to gather required HCI information on how to get the URLs to the service endpoints for Export of Leads and for Export of Activities.
19. Choose Save to save the communication arrangement.
Integrating SAP Cloud for Customer with SAP Hybris Marketing Cloud

Note: This communication scenario can also be used for CRM integration. A Guide for integrating CRM with SAP S/4 HANA Cloud Marketing Edition can be found here: https://rapid.sap.com/bp/BP_CLD_MKT

1.6.2 Communication Arrangement for C4C (UI Navigation)

Procedure
20. Check if an arrangement for scenario “Marketing - SAP Cloud for Customer Integration (UI)” already exists.
21. If not, click on the “New” button.
22. Select communication scenario “SAP_COM_0045 (Marketing – SAP Cloud for Customer Integration (UI))” in value help of Scenario.
23. Enter a meaningful Arrangement Name. Choose Create.
25. Select the communication system for the navigation to C4C you have created in chapter 1.4.2 in value help of Communication System.
26. The outbound communication can be left out.
27. Maintain Outbound services.
28. Service Status should already be flagged as “Active”
29. Port should already be filled with value “443”.
30. Under Path, enter “/”.

### 1.7 How to get the S/4HANA System URL

You can access the S/4HANA system URL via the communication arrangement under section “Inbound Services”. The Service URL’s of the OData services are representing the correct system url.
Please note that you only need the part of the Service URL after “https://” and before “/sap/opu/…”. This part follows the pattern <tenant>-api.<domain>.

1.8 How to get the S/4HANA Client Certificate

You can download the S/4HANA client certificate from the communication system you have created in chapter 1.5.

1. Log on to your SAP S/4 HANA system as an administrator.
2. Choose the Communication Arrangements tile.
3. Select the communication arrangement you have created in chapter 1.5.
4. Choose Download Certificate in Outbound Communication to download the S/4HANA client certificate to your local system.
5. Open the downloaded certificate.
6. Choose Details tab.
7. Choose Copy To File.
8. The Certificate Export Wizard pops up.
10. Specify the name of the file you want to export.
11. Finish the download.

1.9 How to get the Logical System ID

You can get the logical system ID from the communication arrangement you have created in chapter 1.5.

1. Log on to your SAP S/4 HANA system as an administrator.
2. Choose the Maintain Communication Arrangements tile.
3. Select the communication arrangement you have created in chapter 1.6.
4. The logical system ID is displayed in field My System in Common Data.

1.10 Tips on finding Errors during Outbound Processing of Messages

Overview

Information on Leads and Actions is sent from SAP Hybris Marketing Cloud to SAP Cloud for Customer via Enterprise Services. In case the messages cannot be send successfully, a monitoring is required to find and re-process unprocessed messages. SAP S/4HANA uses the so-called Application Interface Framework for message display and message processing.

Procedure

1. Log on to your SAP S/4HANA system as an administrator
2. Go to tile Recipients of Current User
3. Press New Entries
4. Enter Namespace ‘CUAN’
5. Enter a relevant Recipient for the Alerts. Name it “All_Interfaces”
6. Maintain one of the given Message Type
7. Flag Overview and save
8. Go to tile Recipients of a User
9. Enter the user you want to have access to the messages
10. Enter Namespace CUAN
11. Enter the Recipient you entered in step 5
12. Save.

After that procedure, the selected users log on to the system and can navigate to the tile Message Dashboard / SAP AIF to analyze and restart messages and errors. The users can choose the timeframe they want to analyze and will find errors and success messages assigned to the enterprise services that send Leads and Activities to Cloud for customers.
2 Configure Integration in SAP Cloud for Customer

2.1 Activate SAP Hybris Marketing Cloud Integration in Scoping

Purpose
You must check the scope of your SAP Cloud for Customer tenant and ensure that the required integration is active.

Prerequisites
You have received the notification e-mail from SAP Cloud for Customer with the logon details and you have created an administrator user for your Cloud for Customer tenant.

Procedure
1. Logon to Cloud for Customer as a system administrator using the Silverlight UI.
2. In the Business Configuration work center, choose the Implementation Projects view.
3. Select your implementation project and click Edit Project Scope.
4. In the scoping wizard, choose Next until the Scoping screen appears.
5. Expand and select Communication and Information Exchange → Integration with External Applications and Solutions → Integration into Sales, Service, and Marketing Processes, and Integration of Master Data. Then click Next.
   The Questions screen displays only the selected scoping options.
6. Expand Communication and Information Exchange → Integration with External Applications and Solutions → Integration of Master Data
   In the Group: Business Partners select the following scoping options:
   a. Do you want to replicate business partner data from your cloud solution to an external application or solution?
7. Expand Communication and Information Exchange → Integration with External Applications and Solutions → Integration into Sales, Service, and Marketing Processes
   In the Group: Activities select the following scoping options:
   a. Do you want to replicate activities from your cloud solution to an external application or solution?
   b. Do you want to replicate activities from an external application or solution to your cloud solution?
   In the Group: Leads select the following scoping options:
   c. Do you want to replicate leads from an external application or solution to your Cloud solution?
   d. Do you want to replicate leads from your Cloud solution to an external system?
   e. Do you want to replicate marketing leads from your cloud solution to an external system?
   In the Group: Opportunities select the following scoping options:
   f. Do you want to replicate opportunities from your cloud solution to an external application or solution?
8. Choose Next.
9. After you have carefully reviewed and confirmed your entries, click Finish.

**Caution**

Although you have now defined the scoping of the solution, you have not yet deployed it. To do so, confirm the milestone *Design Accepted* in the activity list of the project.

a. Go to Business Configuration view → Open Activity List.
b. Select *Confirm Milestone: Design Accepted*.
c. Select *Design Accepted* and click *Confirm*.

### 2.2 Set Up Communication System

#### Purpose

A communication system represents an external system for communication. You define the SAP SAP Hybris Marketing Cloud tenant as the communication system. Before a communication system can be used for data exchange, communication arrangements must be maintained, as described in the next chapter.

#### Procedure

1. In the Administrator work center, choose Communication Systems.
2. Click New.
3. On the New Communication System screen, in the Basic Information section, enter the following information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>This can be freely defined, and represents the S/4 HANA system.</td>
</tr>
<tr>
<td>SAP Business Suite</td>
<td>Select the checkbox.</td>
</tr>
<tr>
<td>Host Name</td>
<td>See chapter [<em>How to get the fully qualified HCI runtime URL</em>].</td>
</tr>
<tr>
<td>System Access Type</td>
<td>Internet</td>
</tr>
</tbody>
</table>

4. (Optional): In the Contact Information section, you can enter data of the contact person for this system.
5. Save your data.
6. In the Business Instances section, enter the information about the S/4 HANA tenant.

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Instance ID</td>
<td>This can be freely defined, and represents the S/4 HANA tenant.</td>
</tr>
<tr>
<td>Business System ID</td>
<td>Enter the S/4 HANA tenant ID that you have noted down. See chapter [<em>Maintain Communication Arrangements</em>]</td>
</tr>
<tr>
<td>IDoc Logical System ID</td>
<td>Enter the S/4 HANA tenant ID that you have noted down. See chapter [<em>Maintain Communication Arrangements</em>]</td>
</tr>
<tr>
<td>SAP Client</td>
<td>Enter e.g. 100. This is not relevant.</td>
</tr>
<tr>
<td>Preferred Application Protocol</td>
<td>Choose <em>Web Service</em>.</td>
</tr>
</tbody>
</table>

7. Choose Actions → *Set to Active*
8. Choose *Save and Close*. 

© 2017 SAP AG. All rights reserved.
2.3 Configure Communication Arrangements

Purpose
You need to configure and activate the communication arrangements to enable the integration between S/4 HANA and Cloud for Customer.

Note
The number of communication scenarios you can define depends on the scoping you have performed.

Prerequisites
You know the following:
- Communication system ID of S/4 HANA system as maintained in Set Up Communication System.
- Endpoints for the following integration flows in HCI:
  - Lead Replication from SAP Business Suite
  - Lead Replication to SAP Business Suite
  - Business Partner Replication to SAP Business Suite
  - Opportunity Replication to SAP Business Suite
  - Business Activity Replication from SAP Business Suite
  - Business Activity Replication to SAP Business Suite
  See chapter How to get the Integration Flow endpoints in HCI.
- You have the HCI client certificate to upload into SAP Cloud for Customer. See chapter How to get the HCI client certificate.

Procedure
1. Go to Administrator work center. Under Integration, click Communication Arrangements.
2. In the Communication Arrangements view, click New.
3. In the Select Scenario step, select the communication scenario Lead Replication from SAP Business Suite and click Next.
4. In the Define Business Data step, do the following and click Next:
   a. Choose the system instance ID of the SAP S/4 HANA system.
   b. Choose code list mapping as SAP On-Premise Integration.
5. In the Define Technical Data step, under Inbound Communication: Basic Settings, do the following:
   a. Unselect the checkbox for the service Replicate Lead Attachment from SAP Business Suite and Replicate Leads from the SAP Business Suite
   b. Select the checkbox for the service Replicate Lead with Business Partner Address Information from SAP Business Suite and perform the following steps for the service.
   c. Select the Application Protocol as Web Service.
   d. Select Authentication Method as SSL Client Certificate
   e. Click Edit Credentials.

![Certificate Upload Screen](image)

- On the Certificate tab, choose **Upload Certificate**.
- Choose the HCI Client Certificate and click **Open**.
- Click **OK**.

6. Under **Outbound Communication: Basic Settings**, do the following:
   
a. Ensure that the Application Protocol is set to **Format Conversion**.

   Only for the communication arrangement **Confirm Lead Replication to SAP Business Suite**, the Application Protocol has to be **Web Service**.
b. Choose Authentication Method as **SSL Client Certificate**.

c. Click Download. The client certificate downloaded here has to be installed in the HCI system. See chapter *Configure and Deploy Integration Flows using SAP HCI Web UI*.

d. Enter a name for SAP Cloud for Customer Client Certificate x.509 (example C4CSSLClient.cer) and choose Save.

Note

This certificate has to be uploaded while configuring HCI integration flow.

7. Click **Edit Advanced Settings**.

8. Select the **Confirm Lead Replication to SAP Business Suite** service and enter the endpoint of the HCI integration flow. See Prerequisites of this chapter. Ensure that the port is 443.

9. Unselect the checkbox for the service **Notify Lead Status Change to the SAP Business Suite**.

10. Click **Next**. Review the content and click **Finish**.

Repeat the steps for all the communication scenarios listed below and select/unselect the checkbox for the services as described:

- Communication Scenario **Business Partner Replication to SAP Business Suite**
  - Select **Replicate Business Partner to SAP Business Suite**
  - Select **Replicate Business Partner Relationship to SAP Business Suite**
  - Unselect **Replicate Business Partner Direct Responsibility to SAP Business Suite**
Integrating SAP Cloud for Customer with SAP Hybris Marketing Cloud

- Communication scenario Lead Replication from SAP Business Suite
  - Select Replicate Lead with Business Partner Address Information from SAP Business Suite
  - Select Confirm Lead Replication to SAP Business Suite
  - Unselect Replicate Lead Attachment from SAP Business Suite
  - Unselect Replicate Leads from the SAP Business Suite
  - Unselect Notify Lead Status Change to the SAP Business Suite

- Communication scenario Lead Replication to SAP Business Suite
  - Select Replicate Marketing Lead to SAP Business Suite
  - Unselect Replicate Lead Attachment to SAP Business Suite
  - Unselect Replicate Lead to SAP Business Suite
  - Unselect Confirm Lead Replication from SAP Business Suite

- Communication scenario Opportunity Replication to SAP Business Suite
  With 1608, a new, bulk enabled interface was introduced. New customers are recommended to use this interface. Existing customers should consider switching to the new interface, especially if they are performing an initial load or other mass operation, as this should improve the performance over single message processing. You should only have one of the interfaces activated.
  - Select Replicate Bulk Opportunity to SAP Business Suite
  or
  - Select Replicate Opportunity to SAP Business Suite
  - Unselect the other Opportunity Interface
  - Unselect Replicate Opportunity Attachment Folder from SAP Business Suite

- Communication scenario Business Activity Replication to SAP Business Suite
  - Select Replicate Business Activity to SAP Business Suite
  - Unselect Confirm Business Activity Replication from SAP Business Suite
2.4 Change the Assignment of Categories

1. In the Business Configuration work center, choose the Implementation Projects view.
2. Select the project and click Open Activity List.
3. Choose tab Fine-Tune and search for the activity Leads and click on it.
   
   **Note**
   
   If you do not find the activity, choose filter All Activities, search for activity Leads, mark the corresponding line and click on Add to Project.

4. Click on Assign Categories.
5. Add the category 0002 – Telephone Call.
6. Save your entries.

2.5 Perform Code List Mapping

**Purpose**

The codes used in S/4 HANA and Cloud for Customer are not always the same. Therefore, they have to be mapped in Cloud for Customer using the Code List Mapping Tool.

**Procedure**

**Upload Code List Mapping**

1. Go to Note 2355989 in the SAP Service Marketplace.
2. Download the code list mapping file attached to the note to your local computer.
   
   This file will be uploaded to Cloud for Customer in the next steps.
3. Login to the SAP Cloud for Customer solution.
5. Select Upload Code List.
6. Select the code list mapping group OnPremise Integration.
7. Choose Upload.
8. Select the file that you have downloaded under step 2.

**Check the status of Code List Mapping upload in the Application Log**

2. Click on the required Application Log ID.

   The log displays information in the following tabs:

   • General: Displays a high-level summary and administrative data for the job
   • Settings: Displays settings selected during an upload
   • Results: Displays the detailed results of the job including a list of detailed message descriptions, and the nature of the message.
You can also export the information on the tabs to Microsoft Excel®. To do this, click Export to Microsoft Excel®, and select the tab from which you want to export the data.

View Code List Mapping
1. In the Business Configuration work center, choose the Implementation Projects view.
2. Select the project and click Open Activity List.
3. Choose tab Fine-Tune and search for the activity Code List Mapping for Integration with External Applications and Solutions and click on it.
4. Choose Maintain Code List Mapping

Note
The code list mapping UI contains the following three tables, which are hierarchical:

a. Local data type: This shows the data types available in the Cloud for Customer system relevant for Code List Mapping. Select the data type for which you want to view the Code List Mapping.

b. Code list mapping rule: Here we set the code list mapping rules for the data type selected in the above table. There are two rules possible:
   Local and Remote codes are equal: This rule can be used when the values in the Cloud for customer system and the ones in the S/4 HANA system are the same. If this rule is selected, there is no need to do any mapping for the code values.
   Map Individual values: This rule can be used when the codes in the Cloud for Customer system and the ones in the S/4 HANA system are different. If this rule is selected, the individual code values have to be mapped.
c. Code List mapping: Map each code value (only the required ones) for the local data type from Cloud for Customer system with the corresponding values in the S/4 HANA system.
3 Configure Integration in SAP HANA Cloud Integration (HCI)

SAP provides prepackaged, generic integration content called integration flows for the integration of SAP Cloud for Customer with SAP Hybris Marketing Cloud using SAP HANA Cloud Integration.

Prerequisites
You have received the HCI provisioning e-mail and the administrator has created the needed users in HCI. Please refer to User Management for SAP HCI.

3.1 Configure S/4 HANA Communication User Credentials using SAP HCI Web UI

Prerequisites
The communication user is created in SAP S/4 HANA. See Maintain Communication User

Procedure
1. Access the Web UI URL from the provisioning e-mail. It should be in the format: https://<HCI tenant>.hci.us1.hana.ondemand.com/itspaces.
2. In the Monitor tab, navigate to Manage Security Material, and click on Security Material.
3. Click on Add -> User Credential in the right bottom corner.
4. Enter a meaningful Name – this will be referenced in integration flows – a Description, and the User and Password. Do not flag the SuccessFactors check box.
   
   Note
   User Name and Password have to be taken from the communication user created in SAP S/4 HANA.

5. Click on OK.

3.2 Configure and Deploy Integration Flows using SAP HCI Web UI

Prerequisites
1. To be able to import and deploy integration flows, you need the AuthGroup.IntegrationDeveloper role assigned in your tenant.
2. For certificate-based authentication between Cloud for Customer and HCI, you need the client certificate from Cloud for Customer. See chapter Configure Communication Arrangements.
3. For certificate-based authentication between S/4HANA and HCI, you need the client certificate from S/4HANA. See chapter How to get the S/4HANA Client Certificate
Process

1. In the Discover tab, copy all the integration flows to the workspace by clicking on the button with the tooltip Copy to workspace.

![Copy to workspace]

2. In the Design tab, navigate to the package, and click on individual integration flow. Now, click on the Actions icon, and select the Configure option.

Note: Mass configuration of integration flows, is not supported for ODATA adapters. Since SAP Hybris Marketing Cloud uses ODATA adapter to receive data from HCI, each of the integration flows need to be configured individually and deployed

3. Under the Sender tab, select the appropriate authentication method. Both certificate-based and role-based authentication is supported. The default for sender system is role-based authentication, which can be changed using Authentication Type dropdown.

Note: In case the authentication type is Certificate Based Authentication,
If Cloud for Customer (Sender abbreviation C4C) is the sender system, provide the sender system client certificate using the browse button. See chapter Configure Communication Arrangements.
If S/4 HANA (Sender abbreviation yMKT) is the sender system, provide the sender system client certificate using the browse button. See chapter How to get the S/4HANA Client Certificate

4. Under the receiver tab, provide the host name and port for the receiver system. Select the appropriate authentication type (certificate based or role-based authentication). We recommend to use Certificate-based Authentication.

In case S/4 HANA is the receiver (receiver abbreviation yMKT), choose authentication Type Certificate Based Authentication. Take the S/4 HANA System URL without the protocol (https://) as the host name. See chapter How to get the S/4HANA System URL. The port is always 443.

In case Cloud for Customer is the receiver (receiver abbreviation C4C), choose authentication type Certificate Based Authentication. Take the C4C logon URL as provided in the provisioning e-mail without the protocol (https://) as the host name. The port is always 443.

5. Click Deploy

6. You should see a “Deploy Successful” message in the console.

7. Repeat the above steps for all integration flows which you wish to deploy

3.3 How to get the HCI Runtime URL

The HCI Runtime URL is included in the HCI provisioning e-mail.

Alternatively, you can get it from the following place once the integration flow Replicate Lead with Business Partner Address Information from SAP Business Suite is deployed. See Configure and Deploy Integration Flows using SAP HCI Web UI

In the HCI Web UI, navigate to Monitor. Click on the Started tile. Search for the integration flow Replicate Lead with Business Partner Address Information from SAP Business Suite.
Click on status Started. The first part of the listed endpoint is the needed HCI tenant runtime URL. Example https://<tenant>-iflmap.hana.ondemand.com

3.4 How to get the Integration Flow endpoints in HCI
You get the endpoint of an integration flow from the following place once the integration flows are deployed. See Configure and Deploy Integration Flows using SAP HCI Web UI

In the HCI Web UI, navigate to Monitor. Click on the Started tile.

Search for the integration flow e.g. Replicate Lead with Business Partner Address Information from SAP Business Suite. Click on status Started. The second part of the listed endpoint starting with /cxf/ is the needed service endpoint. Example: /cxf/yMKT/C4C/LeadReplicationRequest_Out

3.5 How to get the HCI client certificate
In the HCI provisioning e-mail, follow the link under Certificate Information. In the resulting screen choose X509 Certificate with option Binary CER. Download it to your local machine.

3.6 View and Extend the Deployed Integration Flows using SAP Eclipse
This step is optional and only required if you want to extend the standard integration flows.

Prerequisites
1. Install the SAP HCI Eclipse environment, see https://tools.hana.ondemand.com/#hci
2. Maintain the HCI Operation server details at Windows ➤ Preferences ➤ SAP HANA Cloud Integration ➤ Operation server (see provisioning e-mail for details)
3. Configure and Deploy pre-package content using HCI web UI, see chapter Configure and Deploy the Integration Flow using SAP HCI Web UI. For more information, see Developer's Guide: Managing Integration Content (applicable only for SAP)

3.6.1 Download the Integration Flow projects on your desktop
1. Go to Integration Designer Perspective.
2. In the Project Explorer, On the Eclipse tool bar navigate to File ➜ Import
3. In the Import wizard, select the option Integration Content Archive under SAP HANA Cloud Integration and click Next
4. In the next screen under Import select Tenant Management Node in the Form location dropdown and select your tenant in the Tenant ID dropdown
5. From the Integration content section select the integration flow which you want to download and click Finish
6. The project is imported and displayed under the Project Explorer

3.6.2 View the configured certificates and externalized parameters
1. In the Project Explorer expand the tree view, and double click to open the integration flow found under src.main.resources.scenarioflows.integrationflows.
2. In the Integration Designer, select the integration flow.
3. Within the integration flow, select the sender system, and under Properties tab.
4. If you wish to update the authentication of the integration flow to Basic Authentication, it is possible by, selecting the mode of authentication as Basic Authentication. For more information on configuring basic authentication, see How-To guides.

**Note**
When using Basic Authentication, make sure to create new SCN user or use the existing SCN user and password to authenticate into HCI. The SAP SCN can be accessed from https://scn.sap.com.

5. For Certificate-based Authentication, view the details under the Properties tab.
6. To view the configuration of the integration flow, click on Externalized Parameters tab, under the Value field, and view the configured <host>:<port> information of the receiver system.

### 3.7 Maintain Value Mapping

The value mappings listed in the table below are delivered as part of the pre-packaged HCI content, which can be found in the eclipse project com.sap.sod.scenarios.valuemapping.

**Procedure**

The following procedure explains how to do value mapping in Eclipse. You can also maintain value mapping in SAP HCI Web UI. For more information, see Working with Value Mappings.

1. Import the project com.sap.cod.scenarios.valuemapping into the Eclipse, similar to importing an integration flow.
2. In the Project Explorer, open the value mapping file value_mapping.xml found in the value mapping project.
3. In the value_mapping.xml file, each group element should have two set of agency, schema and value element representing source and target values.
4. Maintain the value mapping based on the requirement by providing the source agency name, source schema name, source value with respective target agency name, target schema name and target value.

**Mandatory Mappings**

**Mapping CUAN-Sender System ↔ COD-Business System (Tenant ID)**

<table>
<thead>
<tr>
<th>CUAN-LogicalSystemID</th>
<th>COD-BusinessSystemID</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is the S/4 HANA tenant ID that you noted down. See chapter Maintain Communication Arrangements</td>
<td>This is the short tenant ID of the SAP Cloud for Customer system.</td>
</tr>
</tbody>
</table>

**Mapping CUAN Logical System ↔ COD Communication Language**

<table>
<thead>
<tr>
<th>CUAN-LogicalSystem</th>
<th>COD-CommunicationLanguage</th>
</tr>
</thead>
</table>
This is the S/4 HANA tenant ID that you noted down. See chapter Maintain Communication Arrangements.

This is the communication language used in SAP Cloud for Customer. Whatever language is given in this Value Mapping also needs to be added in the fine-tuning for Communication Language for Data Replication. By default, it is set to EN.

**Mapping CUAN Origin ↔ COD External System ID**

<table>
<thead>
<tr>
<th>CUAN-Origin</th>
<th>COD-ExternalSystemID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant SAP_HYBRIS_MKT_IC</td>
<td>This is the S/4 HANA tenant ID that you have noted down. See chapter Maintain Communication Arrangements</td>
</tr>
<tr>
<td>Optional: Constant SAP_ERP_CUSTOMER</td>
<td>This is the logical system ID of your ERP system in case you have connected an ERP system to your S/4 HANA.</td>
</tr>
<tr>
<td>Optional: Constant SAP_CRM_BUPA</td>
<td>This is the logical system ID of your CRM system in case you have connected a CRM system to your S/4 HANA.</td>
</tr>
</tbody>
</table>

**Optional Mappings**

The optional mappings are only relevant for special use cases. For example, in a use case where data from an SAP CRM or SAP ERP system is imported into SAP S/4 HANA Cloud Marketing Edition.

**Mapping COD Business System ↔ CUAN System ID**

<table>
<thead>
<tr>
<th>COD-BusinessSystemID</th>
<th>CUAN-SystemID</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is the short tenant ID of the SAP Cloud for Customer system.</td>
<td>This is a system ID that is used as a namespace inside of the SAP Hybris Marketing Cloud System, especially for ID originating from external systems.</td>
</tr>
</tbody>
</table>

**Mapping CUAN Origin ↔ COD Scheme ID**

<table>
<thead>
<tr>
<th>CUAN-Origin</th>
<th>COD-SchemeID</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is an identifier describing the root origin of an ID. Values are for example SAP_ERP_CUSTOMER or SAP_CRM_BUPA. This value is set/provided by SAP S/4 HANA Cloud Marketing Edition depending on the system from which Business Partners are loaded.</td>
<td>This is the number identifying the entity represented by the given ID (for example, 888 representing &quot;Business Partner&quot;). By default, it is set to 888.</td>
</tr>
</tbody>
</table>

**Mapping CUAN Origin ↔ COD External System ID Type**
### Integrating SAP Cloud for Customer with SAP Hybris Marketing Cloud

This is an identifier describing the root origin of an ID. Values are for example SAP_ERP_CUSTOMER or SAP_CRM_BUPA. This value is set/provided by SAP Hybris Marketing Cloud, depending on from which system the Business Partner is loaded.

<table>
<thead>
<tr>
<th>CUAN-Origin</th>
<th>COD-ExternalSystemIDType</th>
</tr>
</thead>
<tbody>
<tr>
<td>This defines what kind of system ID was provided. This is usually BusinessSystem ID or LogicalSystemID. By default, it is set to BusinessSystemID.</td>
<td></td>
</tr>
</tbody>
</table>

### Mapping CUAN_Origin_Account ↔ COD-Origin_Account

This is the indicator whether the value in COD_DEFAULTS-Origin_Account should be used as primary or secondary choice to pass on the ID. Two values must be defined: First_Origin and Second_Origin.

<table>
<thead>
<tr>
<th>CUAN_Origin_Account</th>
<th>COD-Origin_Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defines the origin from which the ID is passed on. It is passed from SAP S/4 HANA Cloud Marketing Edition to SAP Cloud for Customer. If no value is given for First_Origin, the ID of Second_Origin will be used. If this is also not given, origin SAP_HYBRIS_MKT_IC (SAP S/4 HANA Cloud Marketing Edition ID) will be used.</td>
<td></td>
</tr>
<tr>
<td>Default values:</td>
<td>First_Origin: SAP_CRM_BUPA</td>
</tr>
<tr>
<td></td>
<td>Second_Origin: SAP_ERP_ACCOUNT</td>
</tr>
</tbody>
</table>

### Mapping CUAN-Origin_Contact ↔ COD-Origin_Contact

This is the indicator whether the value in COD_DEFAULTS-Origin_Contact should be used as primary or secondary choice to pass on the ID. Two values must be defined: First_Origin and Second_Origin.

<table>
<thead>
<tr>
<th>CUAN-Origin_Contact</th>
<th>COD-Origin_Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defines the origin from which the ID is passed on from SAP Hybris Marketing Cloud to SAP Cloud for Customer. If no value is given for First_Origin, the ID of Second_Origin will be used. If this is also not given, origin SAP_HYBRIS_MKT_IC (SAP Hybris Marketing Cloud ID) will be used.</td>
<td></td>
</tr>
<tr>
<td>Default values:</td>
<td>First_Origin: SAP_CRM_BUPA</td>
</tr>
<tr>
<td></td>
<td>Second_Origin: SAP_ERP_CONTACT</td>
</tr>
</tbody>
</table>

### Mapping CUAN-Origin_Individual_Customer ↔ COD-Origin_Individual_Customer

This defines the origin from which the ID is passed on from SAP Hybris Marketing Cloud to SAP Cloud for Customer. If no value is given for First_Origin, the ID of Second_Origin will be used. If this is also not given, origin SAP_HYBRIS_MKT_IC (SAP Hybris Marketing Cloud ID) will be used.

| Default values: | |
| First_Origin: SAP_CRM_BUPA |
| Second_Origin: SAP_ERP_CONTACT |
### Integrating SAP Cloud for Customer with SAP Hybris Marketing Cloud

This is the indicator whether the value in COD_DEFAULTS-Origin_Individual_Customer should be used as primary or secondary choice to pass on the ID. Two values must be defined: First_Origin and Second_Origin.

<table>
<thead>
<tr>
<th>CUAN-Origin_Individual_Customer</th>
<th>COD-Origin_Individual_Customer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defines the origin from which the ID is passed on. It is passed from SAP Hybris Marketing Cloud to SAP Cloud for Customer. If no value is given for First_Origin, the ID of Second_Origin will be used. If this is also not given, origin SAP_HYBRIS_MKT_IC (SAP Hybris Marketing Cloud ID) will be used. Default values: First_Origin: SAP_CRM_BUPA Second_Origin: SAP_ERP_CUSTOMER</td>
<td></td>
</tr>
</tbody>
</table>

#### Mapping CUAN-CallLeadGroupCode ↔ COD-CallLeadGroupCode

<table>
<thead>
<tr>
<th>CUAN-CallLeadGroupCode</th>
<th>COD-CallLeadGroupCode</th>
</tr>
</thead>
<tbody>
<tr>
<td>This has to be set to the constant CALL_QUALIFICATION.</td>
<td>You can map any value that has been defined in SAP Cloud for Customer configuration for Lead categories. Default values: 0002 &quot;Telephone Call&quot;.</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>This has to be set to the constant CALL_QUALIFICATION.</td>
<td>You can map any value that has been defined in SAP Cloud for Customer configuration for Lead sources. Default values: 003 &quot;Campaign&quot;.</td>
</tr>
</tbody>
</table>

#### Mapping CUAN- CategoryCode ↔ COD- ActivityGroupCode

There is a fix value mapping that provides a mapping for the delivered configuration. If you want to change or enhance this, you can use this value mapping.

<table>
<thead>
<tr>
<th>CUAN- CategoryCode</th>
<th>COD- ActivityGroupCode</th>
</tr>
</thead>
<tbody>
<tr>
<td>These are the values in yMkt Type Category Text</td>
<td>You can map values that have been defined in SAP Cloud for Customer configuration for Activity categories.</td>
</tr>
<tr>
<td>01 05 Preparation</td>
<td>The categories you are using should be assigned to the activity types in assignment of categories</td>
</tr>
<tr>
<td>01 09 Marketing</td>
<td></td>
</tr>
<tr>
<td>02 01 Customer Visit</td>
<td></td>
</tr>
<tr>
<td>02 06 Meeting</td>
<td></td>
</tr>
<tr>
<td>02 06 Meeting</td>
<td></td>
</tr>
</tbody>
</table>

© 2017 SAP AG. All rights reserved.
<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>02</td>
<td>07</td>
<td>Workshop</td>
</tr>
<tr>
<td>02</td>
<td>08</td>
<td>Product Presentati</td>
</tr>
<tr>
<td>02</td>
<td>09</td>
<td>Marketing</td>
</tr>
<tr>
<td>02</td>
<td>10</td>
<td>Annual Visit</td>
</tr>
<tr>
<td>03</td>
<td>02</td>
<td>Telephone Call</td>
</tr>
<tr>
<td>03</td>
<td>09</td>
<td>Marketing</td>
</tr>
<tr>
<td>03</td>
<td>12</td>
<td>Sales Call</td>
</tr>
</tbody>
</table>

Activity Types are

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>Activity Task</td>
</tr>
<tr>
<td>02</td>
<td>Appointment</td>
</tr>
<tr>
<td>03</td>
<td>Phone Call</td>
</tr>
<tr>
<td>04</td>
<td>Visit</td>
</tr>
</tbody>
</table>
4 Initial Load of Data

You can load Business Partners and Business Partner Relationships, Opportunities, Leads and Activities from SAP Cloud for Customer to SAP S/4 HANA.

You can view these objects in SAP S/4 HANA system under the Marketing – Data Management managing groups. You must load business partners before you load the business partner relationships, Opportunities, Leads and Activities.

<table>
<thead>
<tr>
<th>SAP Cloud for Customer</th>
<th>Is visible in the Marketing – Data Management work center as</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Corporate Accounts</td>
</tr>
<tr>
<td>Contact</td>
<td>Contacts</td>
</tr>
<tr>
<td>Individual Customer</td>
<td>Contacts</td>
</tr>
<tr>
<td>Opportunities</td>
<td>Contact Factsheet of Contact/Corporate Account - Interactions</td>
</tr>
<tr>
<td>Leads</td>
<td>Contact Factsheet of Contact/Corporate Account - Interactions</td>
</tr>
<tr>
<td>Activities</td>
<td>Contact Factsheet of Contact/Corporate Account - Interactions</td>
</tr>
</tbody>
</table>

Please note that only specific activities (visits and phone calls) are replicated to SAP S/4 HANA.

1. In the Administrator work center, choose Extract Data to External System.
2. Click on the object you want to load.
3. Specify the selection criteria of the object you want to load to SAP S/4 HANA system.

<table>
<thead>
<tr>
<th>Business System ID</th>
<th>Select the business system ID of the SAP S/4 HANA system</th>
</tr>
</thead>
<tbody>
<tr>
<td>Package Size</td>
<td>Represents the number of business partners that will be transferred in one bulk message. 100 is the default for optimal performance</td>
</tr>
</tbody>
</table>

4. If you want to check the number of object instances that will be loaded to the target system, before triggering the data load, click Test Run. No messages will be initiated to transfer data. Once you decide to initiate the transfer, uncheck the option.
5. Click Execute.
6. You can check the status of the execution and any associated errors in the application log under Data Extraction Results.
Copyrights, Trademarks, and Disclaimers

© 2016 SAP AG or an SAP affiliate company. All rights reserved.
No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors. National product specifications may vary.

These materials are provided by SAP AG and its affiliated companies ("SAP Group") for informational purposes only, without representation or warranty of any kind, and SAP Group shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP Group products and services are those that are set forth in the express warranty statements accompanying such products and services, if any. Nothing herein should be construed as constituting an additional warranty.

SAP and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of SAP AG in Germany and other countries.